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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems. This manual explains how to use the 
e-Filing. Read this manual before using your Multifunctional Digital Systems. Keep this manual within easy 
reach, and use it to configure an environment that makes best use of the e-STUDIO’s functions.

How to read this manual

 Symbols in this manual
In this manual, some important items are descried with the symbols shown below. Be sure to read these items 
before using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this 
equipment with the following signs:

Model and series names in this manual
In this manual, each model name is replaced with the series name as shown below.

*1 The e-Filing functions can be used only when a hard disk is installed.

Indicates a potentially hazardous situation which, if not avoided, could result in death, 
serious injury, or serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as 
required.

Model name Series name in this manual

e-STUDIO5540C/6540C/6550C e-STUDIO6550C Series

e-STUDIO2040C/2540C/3040C/3540C/4540C e-STUDIO4540C Series

e-STUDIO206L/256/306/356/456/506
e-STUDIO256SE/306SE/356SE/456SE/506SE

e-STUDIO456 Series

e-STUDIO556/656/756/856
e-STUDIO556SE/656SE/756SE/856SE

e-STUDIO856 Series

e-STUDIO2050C/2550C e-STUDIO2550C Series*1

e-STUDIO2555C/3055C/3555C/4555C/5055C
e-STUDIO2555CSE/3055CSE/3555CSE/4555CSE/5055CSE

e-STUDIO5055C Series

e-STUDIO287CS/347CS/407CS
e-STUDIO287CSL/347CSL

e-STUDIO407CS Series

e-STUDIO477S/527S
e-STUDIO477SL

e-STUDIO527S Series

e-STUDIO306LP e-STUDIO306LP

e-STUDIO307LP e-STUDIO307LP

e-STUDIO5560C/6560C/6570C e-STUDIO6570C Series

e-STUDIO207L/257/307/357/457/507 e-STUDIO507 Series

e-STUDIO557/657/757/857 e-STUDIO857 Series
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 Screens and Operation Procedures
 Illustrations for the control panel and the touch panel shown in this manual are those of the 

e-STUDIO4540C Series. The shape and location of some buttons on the control panel and the dimension 
of the touch panel of the other models differ depending on the model, however, the names and functions of 
the buttons and parts are the same.

 In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the 
installed options, the OS version and the applications.

 If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens 
or the menu names, etc. may differ.

 The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT 
format, the display or the order of buttons in the illustrations may differ from that of your equipment.

 Trademarks
 The official name of Windows Vista is Microsoft Windows Vista Operating System.
 The official name of Windows 7 is Microsoft Windows 7 Operating System.
 The official name of Windows 8 is Microsoft Windows 8 Operating System.
 The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
 The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
 The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.
 Microsoft, Windows, and the brand names and product names of other Microsoft products are trademarks 

of Microsoft Corporation in the US and other countries.
 Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, iPhone, iPod touch, and TrueType are trademarks of 

Apple Inc. in the US and other countries.
 AirPrint, AirPrint logo, and iPad are trademarks of Apple Inc.
 IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under 

license.
 Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.
 Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. 

and other countries.
 IBM, AT and AIX are trademarks of International Business Machines Corporation.
 NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
 TopAccess is a trademark of Toshiba Tec Corporation.
 Other company and product names given in this manual or displayed in this software may be the 

trademarks of their respective companies.
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e-Filing Features

The e-Filing is installed in a hard disk of this equipment. It allows you to store documents and to print/edit/
manage the stored documents.
This section describes the system of e-Filing for storing documents.

This function is available only when a hard disk is installed in the equipment.

Public Box

The public box is an e-Filing created by default. All users can access it, so it is suitable to store shared 
documents which any user may need to work with. Since the public box is a built-in system box, you cannot 
change the name of the box / create a new box / delete the box.

User Box

The user box is an e-Filing that each user can create. The user box can be protected by a password to limit 
access. It is suitable for specific users or an administrator to store confidential documents. You can also 
create a user box without setting a password. In this case, all users can access the user box as well as the 
public box.
(Up to 200 user boxes can be created.)

Folders

You can create folders in each box. However, you can create only one level of folders within each box. You 
cannot create subfolders within folders.
(Up to 100 folders can be created in a box.)

Documents stored by the 

copying/scanning operation

Documents stored by the 
printing operation (printer 
driver)

Documents stored by 
receiving Internet Fax / FAX

Public Box

Folder

User Box

Folder

All users

Specified users 

(or administrators)

Control Panel Client Computer
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Documents

Documents can be stored in a box or folder in the following methods.
(Up to 400 documents can be stored in a box or folder. / Up to 200 pages can be contained in a document.)
 Copying documents and storing to e-Filing
 Scanning documents and storing to e-Filing
 Printing documents in a client computer and storing to e-Filing
 Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward functions.
 Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward mailbox 

functions.

 Storing the received faxes is available only when FAX Unit (optional) is installed.
 Depending on the amount of data stored in e-Filing, it may take some time from when the equipment is 

turned on to e-Filing becoming ready for use.

 For details of the forward functions, refer to the TopAccess Guide.
 For details of the forward mailbox functions, refer to the GD-1320/GD-1350/GD-1270/GD-1260 

Operator's Manual for FAX Unit / User’s Manual Advanced Guide and TopAccess Guide.
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e-Filing Functions

 Functions operated with this equipment
Below is a list of e-Filing functions that you can operate with this equipment. For details of the operation, see 
the references described below.

 Printing documents
The following functions allow you to print documents stored in the e-Filing.
 To print an entire document
 P.12 “Printing an entire document”

 To print specified pages of the document for confirmation
 P.16 “Test print”

 Storing documents
The following functions allow you to store documents in the e-Filing.
 To copy and store documents
 P.18 “Copying and storing to e-Filing”

 To scan and store documents
 P.24 “Scanning to e-Filing”

Deleting documents
To delete documents in the e-Filing
 P.27 “Deleting Documents”

Managing user boxes/folders
The following functions allow you to manage user boxes and folders in the e-Filing. You cannot create and edit 
folders in boxes using the control panel. Folders can be created using a client computer.
 To create new user boxes
 P.29 “Creating user boxes”

 To change the registered user box name and password
 P.31 “Editing user boxes”

 To delete user boxes and folders
 P.34 “Deleting user boxes/folders”
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 Functions operated with a client computer
Below is a list of e-Filing functions that you can operate with a client computer (e-Filing web utility). For details 
of the operation, see the references described below.

e-Filing web utility supports only Windows. Mac OS and other computers are not supported.

Managing user boxes/folders
The following functions allow you to manage user boxes and folders in the e-Filing.
 To create new user boxes and folders
 P.50 “Creating user boxes and folders”

 To delete user boxes and folders
 P.53 “Deleting user boxes and folders”

 To edit (renaming and changing Properties) user boxes and folders
 P.56 “Renaming user boxes and folders”
 P.60 “Modifying and displaying user box and folder properties”

Managing documents
The following functions allow you to manage documents stored in the e-Filing.
 To display document image files in thumbnail view and list view
 P.68 “Displaying documents”

 To rename documents
 P.69 “Renaming documents”

 To delete documents
 P.71 “Deleting documents”

 To print documents (entire document/test print)
 P.72 “Printing an entire document”
 P.76 “Selecting test print”

 To store documents by printing operation
 P.79 “Storing documents”

 To archive documents
 P.82 “Archiving documents”

 To send documents as Emails
 P.88 “Sending Email”

 Editing documents
The following functions allow you to edit documents stored in the e-Filing.
 To display document and page Properties
 P.99 “Displaying document and page properties”

 To copy/cut pages from a document and paste them into another one
 P.100 “Copying pages from one document to another”

 To copy/cut pages from a document and save them as a new document
 P.105 “Copying pages from a document to a box or folder”

 To delete pages from a document
 P.109 “Deleting pages from a document”

 To insert blank pages into a document
 P.112 “Inserting a blank page into a document”

 To move pages within a document to arrange the page order
 P.115 “Moving pages within a document”

 To move documents between boxes or folders
 P.118 “Moving documents”

 To copy an entire document and insert them into another document
 P.120 “Merging documents”
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 You can import e-Filing documents into a client computer using TWAIN Driver and File Downloader.
 You can back up or restore documents in e-Filing and various settings of e-Filing using the e-Filing 

Backup/Restore Utility.
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Printing Documents

You can print documents stored in the e-Filing using the control panel of this equipment.
 P.12 “Printing an entire document”
 P.16 “Test print”

 Printing an entire document
You can print an entire document.

1 Press the [e-FILING] button on the control panel.

2 Select the box that contains a document you want to print.

Press  or  to switch the pages. You can also specify the box number (3-digit) using the digital 
keys.
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 Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In 
this case, press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, 
and then press [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

3 If the document is stored in a folder, select the folder and press [OPEN].

If the document is stored outside of the folder, this operation is not necessary.
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4 Select the document. To change the print settings, press [SETTINGS]. To perform 
printing without changing them, press [PRINT].

If you press [SETTINGS], proceed to step 5.
If you press [PRINT], printing will start. When you want to stop printing, see “Deleting print job” in step 
6.

Press  to preview thumbnail images of the documents. Select the desired one and press 

[OPEN] to display its contents. Press  to return to the list.

5 Change the print settings as necessary.

You can operate the print settings as below. For step 3 to 8, when each button of the menu is pressed, 
the setting screen appears. Perform the appropriate operations. These operations of settings are the 
same as the one of copy modes. For details of the operation, refer to the Copying Guide / User’s 
Manual Basic Guide.

1 6 7 8

3 4 5

2
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1) Select the paper feeder. However, if the selected paper size is different from the actual one, the 
selection will be cancelled and automatic paper selection will be applied.

2) Key in the number of copies to be printed using the digital keys.
3) Select the duplex printing mode. If you do not want to print on both sides of the paper, select [1 

SIDE] in the menu.
4) Select the finishing mode. The available finishing modes differ depending on the type of finishing 

device installed.
5) Select the receiving tray. This button is available only when the Finisher (optional) is installed.
6) Set the position and width of the margin.
7) Set the position of the date and time to be printed.
8) Set the position of the page number to be printed.

6 Press [PRINT].

 Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the Copying Guide / User’s Manual Basic Guide.



2 OPERATIONS WITH THIS EQUIPMENT

16    Printing Documents

 Test print
You can print specified pages of the document for confirmation.

1 Press the [e-FILING] button on the control panel.

2 Select the box or folder that contains documents you want to print.

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are 
the same as those for one of printing an entire document.
 P.12 “Printing an entire document”

3 Select the document you want to print, and then press [TEST PRINT].

Press  to preview thumbnail images of the documents. Select the desired one and press 

[OPEN] to display its contents. Press  to return to the list.
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4 Key in page numbers in [FIRST PAGE] and [LAST PAGE], then press [PRINT].

 Select [FIRST PAGE] or [LAST PAGE], then specify the page numbers using the digital keys on the 
control panel.

 If you press the [CLEAR] button on the control panel, the value entered in the currently selected box 
can be deleted.

 To print entire pages of the document, press [ALL PAGES].

 Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the Copying Guide / User’s Manual Basic Guide.
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Storing Documents

You can store documents in e-Filing using the control panel of this equipment.
 P.18 “Copying and storing to e-Filing”
 P.24 “Scanning to e-Filing”

 Store confidential documents in a user box protected by a password.
 Up to 400 documents can be stored in a box or folder, and up to 200 pages can be contained in a 

document.
 The maximum capacity in the shared folder differs depending on your model or operating environment. 

The total available space in the shared folder and e-Filing can be checked on the [Device] tab in 
TopAccess.

 Saving in the e-Filing is not for permanent use. Delete unnecessary documents immediately. 
 P.27 “Deleting Documents”

 You need to select the original size by yourself when placing the following originals whose sizes cannot 
be detected correctly:
- Highly transparent originals (e.g. overhead transparencies, tracing paper)
- Totally dark originals or originals with dark borders
- Non-standard size originals (e.g. newspapers, magazines)

For details, refer to the Copying Guide / User’s Manual Basic Guide.

 When you store documents in user boxes and folders, you need to create them in advance.
 P.29 “Creating user boxes”(Operating with this equipment)
 P.50 “Creating user boxes and folders” (Operating with a client computer)

 You can set the storage period for documents in the Box Properties window in a user box. The 
documents will be deleted after the specific number of days have passed.
 P.60 “Modifying and displaying user box and folder properties” (Operating with a client computer)

Copying and storing to e-Filing
You can copy and store documents in e-Filing. The e-Filing documents can be copied and stored at the same 
time.

 Documents, whose paper sizes are shown below, cannot be stored in e-Filing.
- Custom paper
- Non-standard size paper (bypass tray)

 A document stored by “Copying and storing to e-Filing” is suitable for output, but not for importing as an 
image into a client computer. To get the best image quality for importing an image into your computer, 
store the document by “Scanning to e-Filing”.
 P.24 “Scanning to e-Filing” 

1 Place the original(s) and set the copy mode as necessary.
For details of placing original(s) and copy mode settings, refer to the Copying Guide / User’s Manual 
Basic Guide.

On copy mode settings, even when “TWIN COLOR COPY” or “MONO COLOR” is selected on the 
[IMAGE] tab, this mode is invalid for storing documents in e-Filing. This mode is also invalid for 
copying documents at the same time as storing them.
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2 Press [STORAGE] on the copying screen.

If the copying screen is not displayed, press the [COPY] button on the control panel.

3 Press [STORE TO E-FILING].

4 Press [BOX/FOLDER].
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5 Select the box in which you want to store the data.

Press  or  to switch the pages. You can also specify the box number (3-digit) the using digital 
keys.

 Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In 
this case, press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, 
and then press [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.
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6 To store the original(s) in the selected box, press [OK].

 Storing in a folder
Select the folder and press [OPEN], the list in the folder is displayed. To store the original(s) in the 
selected folder, press [OK].
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7 Change the document name as necessary, then press [OK].

 Renaming the documents
When you press [DOCUMENT NAME], the on-screen keyboard is displayed. Key in the document 
name using the keyboard and the digital keys (up to 64 characters), then press [OK].

For details of the on-screen keyboard, refer to the Quick Start Guide / User’s Manual Setup Guide.

 A character string composed of "DOC", year, month and date is displayed by default. This format 
can be changed in TopAccess. For details, refer to the TopAccess Guide.

 If the same name has already been stored, a serial number (-001, -002…) will be automatically 
added to the end of the file name and stored.

8 When the copy confirmation screen appears, press [YES] to store and print the 
document. If you want to store the document without printing it, press [NO].
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9 Press the [START] button on the control panel.

 Copying the next original
Depending on how the original is set, the confirmation screen to copy next the original may be 
displayed. Repeat the procedure below as many times as necessary. When the scanning of the last 
page of the original finishes, press [JOB FINISH].
 When the original is set on the glass, place the next original and press [NEXT COPY] or [START] 

button on the control panel, scanning will start.
 When the original is set on the RADF (Reversing Automatic Document Feeder)* in the SADF (single 

feed mode), scanning will start when the next original is set. (You do not need to press any key.)
* For the e-STUDIO4540C Series, e-STUDIO456 Series, e-STUDIO2550C Series, e-STUDIO5055C Series , 

e-STUDIO306LP, e-STUDIO307LP and e-STUDIO507 Series, the RADF is optional.

 Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the Scanning Guide / User’s Manual Basic Guide.
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 Scanning to e-Filing
You can scan and store documents in e-Filing. When you import an original as an image into a client 
computer, it is recommended to store the document using Scan to e-Filing.

1 Place the original(s).
For details of placing original(s), refer to the Copying Guide / User’s Manual Basic Guide.

2 Press the [SCAN] button on the control panel.

3 Press [e-FILING].

Set [SCAN SETTING] and check [PREVIEW] as necessary. These operations are the same as the 
one of other scanning functions. For details of the operation, refer to the Scanning Guide / User’s 
Manual Basic Guide.

[PREVIEW] can be selected only when any of the following models is used.
- e-STUDIO6570C Series
- e-STUDIO6550C Series
- e-STUDIO4550C Series
- e-STUDIO2550C Series (only when a hard disk is installed)
- e-STUDIO5055C Series
- e-STUDIO507 Series
- e-STUDIO857 Series
- e-STUDIO407CS Series
- e-STUDIO527S Series
- e-STUDIO307LP

To use this, the scanning function is required.
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4 Select the box or folder in which you want to store the documents. Change the 
document name as necessary, then press [OK].

The instructions of the operating procedure as to selecting a box/folder and changing a document 
name are omitted, because they are the same as those for copying and storing to e-Filing.
 P.18 “Copying and storing to e-Filing”

5 Press [SCAN].

When the original is set on the RADF (Reversing Automatic Document Feeder)*, pressing [CONTINUE] 
on the screen during scanning can start the scanning of another original after the current one.
 P.26 “Scanning the next original”
* For the e-STUDIO4540C Series, e-STUDIO456 Series, e-STUDIO2550C Series, e-STUDIO5055C Series, e-STUDIO306LP, 

e-STUDIO307LP and e-STUDIO507 Series, the RADF is optional.

The acceptable number for reserving scanning jobs differs depending on the settings. If the 
reserved jobs exceed the corresponding number, the full reservation message will be displayed. In 
this case, wait until the reserved scanning jobs are reduced or delete unnecessary reservations 
(scanning jobs) as described below.
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 Scanning the next original
When the original is set on the glass or [CONTINUE] is pressed during scanning on the RADF, the 
confirmation screen for the next original will be displayed.
In either case, when you set the next original and press [SCAN], it will be scanned. Follow this 
procedure as many as times as necessary. When all of the scanning is finished, press [JOB FINISH].

 You can change the scan setting by pressing [SCAN SETTING].
 You can cancel the reservation of the scanned data by pressing [JOB CANCEL].

 Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the Scanning Guide / User’s Manual Basic Guide.
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Deleting Documents

You can delete documents in e-Filing using the control panel of this equipment.

e-Filing is not designed for saving documents permanently. Delete unnecessary documents immediately.

If you delete a folder or box, all the documents in the folder or box are deleted as well.
 P.34 “Deleting user boxes/folders” (Operating with this equipment)
 P.53 “Deleting user boxes and folders” (Operating with a client computer)

1 Press the [e-FILING] button on the control panel.

2 Select a box or folder that contains a document you want to delete.

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are 
the same as those for printing an entire document.
 P.12 “Printing an entire document”
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3 Select the document you want to delete and then press [DELETE].

Press  to preview thumbnail images of the documents. Select the desired one and press 

[OPEN] to display its contents. Press  to return to the list.

4 When the confirmation screen appears, press [DELETE] to delete the selected 
document.

You can cancel the deletion of the selected document by pressing [CANCEL].
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Managing User Boxes/Folders

You can manage user boxes and folders in the e-Filing using the control panel of this equipment.
 P.29 “Creating user boxes”
 P.31 “Editing user boxes”
 P.34 “Deleting user boxes/folders”

Folders can be created and edited using a client computer.
 P.50 “Creating user boxes and folders”
 P.56 “Renaming user boxes and folders”
 P.60 “Modifying and displaying user box and folder properties”

Creating user boxes
You can create user boxes (up to 200).

1 Press the [e-FILING] button on the control panel.

2 Press the [BOX SETTING] tab, select an unregistered button numbered from “001” to 
“200”, then press [SETUP].

Press  or  to switch the pages. You can also directly specify the box number (3-digit) the using 
digital keys.
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3 Press [BOX NAME] and enter the box name.

 Entering box name
Press [BOX NAME]. The on-screen keyboard is displayed. Key in the box name (up to 32 characters) 
using the keyboard and the digital keys, then press [OK]. However, the following one-byte characters 
cannot be used. A space or period cannot be used at the beginning or end of the name. If these 
characters are keyed in, an error message informing you of the invalid character used is displayed.
" # % & ' = | { } * < > ? [ ] ; : / \ ,

For details of the on-screen keyboard, refer to the Quick Start Guide / User’s Manual Setup Guide.
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4 Enter the password in the [PASSWORD] and [RETYPE PASSWORD] boxes, then press 
[OK].

 Press [PASSWORD] and then [RETYPE PASSWORD]. Enter the password using the digital keys or 
the on-screen keyboard. You can also create a user box without setting a password. In this case, all 
users can access the user box as well as the public box.

 If you press the [CLEAR] button on the control panel, the value entered in the currently selected box 
can be deleted.

 If the entered password does not meet the Password Policy, a warning message appears. Enter 
the correct one.
For details of the Password Policy, refer to the TopAccess guide.

 The password input is displayed in the blank symbols.

 Editing user boxes
You can change the registered user box name and password.

1 Press the [e-FILING] button on the control panel.
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2 Press the [BOX SETTING] tab, select the user box that you want to edit, and then press 
[EDIT].

Press  or  to switch the pages. You can also directly specify the box number (3-digit) the using 
digital keys.

 Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In 
this case, press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, 
and then press [OK].

 You can also enter the administrator password to open the user box instead of the password.
 The password input is displayed in the blank symbols.
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3 Change [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] as necessary, and then 
press [OK].

The instructions of the operating procedure of [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] 
settings are omitted, because they are the same as those for creating user boxes.
 P.29 “Creating user boxes”
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Deleting user boxes/folders
You can delete user boxes and folders.

If you want to delete a folder or a box, all documents in the folder or the box are deleted as well.

1 Press the [e-FILING] button on the control panel.

2 Follow the procedure below to delete user boxes and folders.

 Deleting user boxes
Press the [BOX SETTING] tab, select the user box you want to delete and then press [DELETE].

The instructions for the operating procedure for selecting user boxes are omitted, because they are the 
same as those for editing user boxes.
 P.31 “Editing user boxes”

 Deleting folders
Press the [PRINT] tab, select the folder you want to delete and then press [DELETE].

The instructions for the operating procedure for selecting folders is omitted, because it is the same as 
the one of printing an entire document.
 P.12 “Printing an entire document”
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3 When the confirmation screen appears, press [DELETE] to delete the selected box/
folder.

You can cancel the deletion of the selected box/folder by pressing [CANCEL].
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Before Using the e-Filing Web Utility

Before using the e-Filing web utility, check the following items on your computer.
 P.38 “System requirements”

System requirements

The e-Filing web utility works with the following browsers for the Microsoft Windows operating system:
 Internet Explorer 8.0 or later
 Firefox 24 or later
 Chrome 30 or later
 The minimum display resolution required for these browsers is 800 x 600.
 When using Internet Explorer, the Privacy setting must be set to Medium on the browser. Do not set Block 

All Cookies or High for the Privacy function. For instructions on the Privacy setting, see the following 
procedure.

 Disable the popup block function of the Web browser. For instructions on how to set the popup block 
function, refer to the HELP for the Web browser you are using.

e-Filing does not support access from Safari.

How to set the privacy settings in Internet Explorer
When you are using Internet Explorer, make sure that the Privacy setting is correct as follows.

1 Launch Internet Explorer and select [Internet Options] in the [Tools] menu.

The [Internet Options] dialog box appears.
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2 Display the [Privacy] tab and move the slider to “Medium” and click [OK].

The Privacy setting is saved.

3 Exit from Internet Explorer and launch it again before accessing e-Filing.

Exit from Internet Explorer after accessing the e-Filing web utility. To log off from the e-Filing web 
utility in the user mode, click the Log-out link and then exit from Internet Explorer.
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Getting Started With the e-Filing Web Utility

This section describes how to launch and exit from the e-Filing web utility. The way to launch the utility differs 
depending on whether you log in as a user or a system administrator.

 P.40 “Logging in as a user”
 P.42 “Logging in as a system administrator”

 Logging in as a user
There are two ways to access the e-Filing web utility:
 Click the e-Filing web utility link in the TopAccess web site.
 Enter the e-Filing web utility URL in the address field of your Web browser.

The e-Filing web utility URL is: http://[IP address]/?MAIN=EFILING
The [IP address] portion will be the IP address of this equipment. You can also use the DNS name of this 
equipment instead of the IP address.
For example, the IP address of this equipment is 192.168.1.2

http://192.168.1.2/?MAIN=EFILING
For example, the DNS name of this equipment is mfp-00000236

http://mfp-00000236/?MAIN=EFILING

If SSL is enabled for the HTTP network service, the e-Filing web utility will also be accessed by using SSL.

When the User Management Setting has been enabled, the log-in page will be displayed when accessing the 
e-Filing web utility URL. In that case, please enter your User Authentication user name and password to log in 
to the main page of the e-Filing Web Utility.

 If you enter an invalid authentication password several times to log into the TOSHIBA MFP, you may 
not be able to log in for a certain period since it will be regarded as an unauthorized access.

 The password input is displayed in the blank symbols.
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 Users can launch the e-Filing web utility to use its functions.
 Access to the e-Filing web utility will be timed out according to the Session Timer setting in the WEB 

General Setting of TopAccess.
 To use the administrator’s functions of the e-Filing web utility, you must log in as a system administrator 

after accessing it.
 P.42 “Logging in as a system administrator”
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 Logging in as a system administrator
To log in as a system administrator, follow the steps below after launching the e-Filing web utility.

"System administrator" and "User with an administrator privilege" are defined as follows in this manual.
- System administrator: 

User with the administrator role
- User with an administrator privilege: 

User whose ID is "Admin"

1 Click the Log-in link located at the upper right of the page.

The Administrator Log-in page is displayed.

2 Enter the administrator password in the [Password] box and click [Login].

The [Administration] tab appears in the main tabs.

 If you enter an invalid authentication password several times to log into the e-Filing web utility in 
the administrator mode, you may not be able to login for a certain period since it will be regarded 
as an unauthorized access.

 To log off from the e-Filing web utility in the administrator mode, click the Log-out link and be sure 
to close your web browser to prevent unauthorized access by other users.

 The administrator password is the same as the password that has been set in the TopAccess or 
touch panel display for the administrator. The default administrator password is “123456” if you 
have not changed it.

 The password input is displayed in the blank symbols.
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About the Main Tabs

The user interface of the e-Filing web utility consists of three main tabs located in the upper-right corner of the 
web browser’s window: the [Documents] tab, [Preferences] tab, and [Administration] tab.

These main tabs enable you to display and work with your documents, set up viewing preferences, and 
perform administrative functions.
 P.43 “[Documents] tab”
 P.45 “[Preferences] tab”
 P.46 “[Administration] tab”
In addition, the Log-in link is located to the right of the main tabs which allows you to log in as a system 
administrator.
 P.47 “Log-in link”

 [Documents] tab
The [Documents] tab is the default page and is available to all users. It consists of the Folders and Document 
frame, the Menu Bar, and the Contents frame.

4

1

2 3
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1) Document Frame
The Document frame is an Explorer-style user interface. Use the Folders and Document frame to locate 
the folders and documents with which you want to work.
In the Document frame, the following icons are displayed according to the items:
- Box Icons

- Folder Icons

- Document Icons

2) Menu Bar
The Menu bar is located below the main tabs: File, Edit, View, and Layout.

3) Tool Bar
The Tool bar is located below the main tabs: Send Email, Save, Test Print, Cut, Copy, Paste, Beginning, 
Previous, Next, and End. These buttons provide you with a one-click access to various functions.

This icon indicates a closed box.

This icon indicates an opened box.

This icon indicates a closed box that is protected by a password.

This icon indicates an opened box that is protected by a password.

This icon indicates a closed folder.

This icon indicates an opened folder.

This icon indicates a document that was stored by a print operation. When the icon is 
displayed on a white background, it indicates that the document is currently in the View 
mode. When the icon is displayed on a blue background, it indicates that the document is 
currently in the Edit mode.

This icon indicates a document that was stored by a scan operation. When the icon is 
displayed on a white background, it indicates that the document is currently in the View 
mode. When the icon is displayed on a blue background, it indicates that the document is 
currently in the Edit mode.

This icon indicates a document that was stored by a copy operation. When the icon is 
displayed on a white background, it indicates that the document is currently in the View 
mode. When the icon is displayed on a blue background, it indicates that the document is 
currently in the Edit mode.

This icon indicates a document that was stored by a fax operation via the mailbox function, 
fax received forward function, or Internet Fax received forward function. When the icon is 
displayed on a white background, it indicates that the document is currently in the View 
mode. When the icon is displayed on a blue background, it indicates that the document is 
currently in the Edit mode.

This icon indicates a document that was created by merging several documents. When the 
icon is displayed on a white background, it indicates that the document is currently in the 
View mode. When the icon is displayed on a blue background, it indicates that the document 
is currently in the Edit mode.

Click this button to send the selected documents as Email.

Click this button to save the document. This is enabled only when you are displaying the 
document in the Edit mode.

Click this button to perform a test print.

Click this button to cut the selected documents or pages.

Click this button to copy the selected documents or pages.

Click this button to paste the items that have been copied.
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4) Contents Frame
The Contents frame displays the documents or pages with which you are working. There are also 
document control buttons located below the menu bar. You can use these buttons to change the document 
status between the View mode and Edit mode, and use the Contents frame to print and edit your 
documents.

For more information about the document control buttons, see the following section:
 P.98 “About the Document Control Buttons”

 [Preferences] tab
The [Preferences] tab is available to all users. It allows you to make the default condition for document 
viewing and the number of thumbnail images displayed on the screen.

1) Default Document View
You can select the Thumbnail or List view. The system displays your documents by the selected view until 
you choose another option from the View menu. The default is the Thumbnail view.

2) Load [number] thumbnails per view.
Use the drop-down list box to select the number of thumbnail images displayed on the screen as 4, 8 or 
12. The default is 8.

3) Display the progress bar.
Select the [Display the progress bar.] check box to display the progress bar when copying, cutting, or 
pasting the documents or pages, deleting pages, or saving documents.

4) [Save]
Click this button to apply your new settings.

5) [Reset]
Click this button to restore the default settings.

Click this button to display the first items in the Contents frame.

Click this button to display the previous set of items in the Contents frame.

Click this button to display the items that immediately follow those displayed in the Content frame.

Click this button to display the last items in the Contents frame.

1

2

3

4

5
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 [Administration] tab
The [Administration] tab allows the system administrator to manage the data in e-Filing. The [Administration] 
tab is only visible if you are logged on as the system administrator.
The [Administration] tab has the following subtab:
 P.46 “[Box Management] subtab”

An administrator can also set up the e-Filing notifications by using TopAccess in the administrator mode. 
For more information about setting up the notifications for e-Filing, refer to the TopAccess Guide.

 [Box Management] subtab
This subtab enables you manually to delete user boxes that are no longer required or have become corrupted. 
Use this feature to restore the available hard disk space. 
You can also unlock user boxes which have been locked by incorrect password entries.

1) e-Filing Disk Space Available
This item displays the available hard disk space for storing the e-Filing data.

2) Box Number / Box Name / Used capacity / Status
This item displays a list of all user boxes. When you click a box number or box name link, the Box 
Properties window opens and you can see the detail properties of the box. If the user box is locked, the 
lock status is displayed in the results. To delete or unlock a user box, select the check box on the left of 
each property, and then click [Delete] or [Unlock].

3) [Delete]
Click this button to delete the selected boxes. Before doing so, first select the check boxes of the user 
boxes that you want to delete.

 You cannot delete the public box.
 For instructions on how to erase user boxes, see the following section:
 P.126 “Erasing boxes”

4) [Unlock]
Click this button to unlock the selected boxes. Before doing so, first select the check boxes of the user 
boxes that you want to unlock.

For instructions on how to unlock the user boxes, see the following section:
 P.127 “Unlocking user boxes”

1

3

4

2
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 Log-in link
The Log-in link that is displayed next to the main tabs allows you to log in as a system administrator.
 P.47 “Administrator log-in page”
You can perform the administrative function from the [Administration] tab that will be displayed after you log in 
as a system administrator.
 P.46 “[Administration] tab”

Administrator log-in page
You must enter the system administrator password to log in as an administrator.

1) Password
Enter the system administrator password that is same as the administrator password on the touch panel 
display and TopAccess.

2) [Login]
Click this button to log in as a system administrator.

3) [Cancel]
Click this button to cancel login and return to the main page.

1

3

2
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Managing User Boxes and Folders

The e-Filing web utility provides two box types: the public box and user box. Each user can create his or her 
own user box, and also create one level of folder in each box.
This section explains the following operations:
 P.50 “Creating user boxes and folders”
 P.53 “Deleting user boxes and folders”
 P.56 “Renaming user boxes and folders”
 P.60 “Modifying and displaying user box and folder properties”

For a detailed explanation of the public box and user box, see the following page:
 P.6 “e-Filing Features”

Creating user boxes and folders
Each user can create his or her own user box, and also protect the box with a password, if required.
 P.50 “Creating user boxes”
 P.51 “Creating folders”

Creating user boxes
This operation allows you to create up to 200 user boxes and protect each box with a password.

You can also create user boxes from the control panel. For instructions on how to create user boxes from 
the control panel, see the following page:
 P.29 “Creating user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 Make sure that you are selecting “e-Filing” in the Document frame, and select [New 
Box] from the [File] menu.

The New Box window appears.

3 Define the box properties as required and complete the operation.
1) Select a box number in the [Box Number] box.

Users cannot select existing box numbers in the [Box Number] box. Only undefined box numbers 
appear in this drop-down list box.

2) Enter the box name in the [Box Name] box.
Box names can consist of any ASCII characters except: \ / < > " % & = ' ; : * ? | # [ ] { }. Do not use a 
space or period at the beginning or end of the name. The maximum size of a box name is 32 
characters.
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3) If you want to protect the box with a password, enter one in the [Box Password] and [Confirm 
Password] boxes.
The password input is displayed in the blank symbols.

4) Click [OK].

The created user box appears in the Document frame.

Users can configure advanced properties for each box such as how long the box will retain 
documents, and Email notification features.
 P.60 “Modifying box properties”

Creating folders
This operation allows you to create up to 100 folders in each box.

 Only single-level folders can be created in each box. You cannot create subfolders in the folders.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box where you want to create a folder.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Click the [File] menu and select [New Folder].

The New Folder window appears.

5 Enter the folder name in the [Name] box and click [OK].

The created folder appears under the selected box in the Document frame.

Folder names can consist of any ASCII character except \ / < > " % & = ' ; : * ? | # [ ] { }. Do not use 
a space or period at the beginning or end of the name. The maximum size of a folder name is 64 
characters.
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Deleting user boxes and folders
This operation allows you to delete user boxes and folders.
 P.53 “Deleting user boxes”
 P.54 “Deleting folders”

When the box has been protected with a password, you must enter it to delete the box and folders. Users 
with an administrator privilege can delete all user boxes and folders by using their password.

Folders in the public box can be deleted, although you cannot delete the public box itself.

Deleting user boxes
This operation allows you to delete user boxes. If a user box is deleted, all folders and documents in the box 
are also deleted.

You can also delete user boxes from the control panel. For instructions on how to delete user boxes from 
the control panel, see the following page:
 P.27 “Deleting Documents”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to delete.

3 If you select a user box which is protected with a password, the Password 
Authentication window appears. Enter the password in the [Box Password] box and 
click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [Edit] menu and select [Delete].

The confirmation message dialog box appears.

5 Click [OK].

The selected box is deleted.

Deleting folders
This operation allows you to delete folders in the public box and user boxes. If a folder is deleted, all 
documents in the folder are also deleted.

You can also delete folders from the control panel. For instructions on how to delete folders from the 
control panel, see the following page:
 P.34 “Deleting user boxes/folders”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folders that you want to delete.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

All folders and documents in the box are displayed in the Contents frame.

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check boxes of the folders that you want to delete and select [Delete] from 
the [Edit] menu.

The confirmation message dialog box appears.

You can also delete a folder by selecting the folder in the Document frame, clicking on the [Edit] 
menu and selecting [Delete]. In that case, make sure that no documents are selected in the 
Contents frame. If any documents are selected, they will be deleted instead of the selected folder.

5 Click [OK].

The selected folders are deleted.
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Renaming user boxes and folders
This operation allows you to rename the user boxes and folders.
 P.56 “Renaming user boxes”
 P.58 “Renaming folders”

When the box has been protected with a password, users must enter it to rename the box or folders. Users 
with an administrator privilege can rename all user boxes and folders by using their password.

You can rename folders in the public box, but cannot rename the public box itself.

Renaming user boxes

Do not turn off the power of the equipment when changing the box name. All folders and documents in the 
box will be lost if the power is turned off while the system is saving a new name.

Users can rename user boxes from the control panel. For instructions on how to rename user boxes from 
the control panel, see the following page:
 P.31 “Editing user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to rename.
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3 If you select a user box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Click the [File] menu and select [Rename].

The Rename Box window appears.

Make sure that no folder or document is selected in the Contents frame. If a folder or document is 
selected, it will be renamed instead of the selected box.

5 Edit the name in the [Name] box and click [OK].

The confirmation dialog box appears.

Box names can consist of any ASCII characters except \ / < > " % & = ' ; : * ? | # [ ] { }. Do not use a 
space or period at the beginning or end of the name. The maximum size of a box name is 32 
characters.
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6 Click [OK].

The selected box is renamed.

Renaming folders

Do not turn off the power of the equipment when changing the folder name. All documents in the folder will 
be lost if the power is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folder you want to rename.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. In this case, enter the password in the [Box Password] box and click 
[OK].

All folders and documents in the box are displayed in the Contents frame.

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check box of the folder that you want to rename and select [Rename] from 
the [File] menu.

The Rename Folder window appears.

 Do not select several folders at the same time. You can only rename one folder at a time.
 You can also rename a folder by selecting the folder in the Document frame, clicking on the [File] 

menu and selecting [Rename]. In that case, make sure that no document is selected in the 
Contents frame. If a document is selected, it will be renamed instead of the selected folder.

5 Edit the name in the [Name] box and click [OK].

The confirmation dialog box appears.

Folder names can consist of any ASCII character except \ / < > " % & = ' ; : * ? | # [ ] { }. Do not use 
a space or period at the beginning or end of the name. The maximum size of a folder name is 64 
characters.

6 Click [OK].

The selected folder is renamed.
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Modifying and displaying user box and folder properties
This operation allows you to display and modify the properties of user boxes such as the box password and 
maintenance period to automatically delete documents, and Email notification settings. This operation also 
allows you to view and confirm the folder properties.
 P.60 “Modifying box properties”
 P.63 “Displaying folder properties”

When the box has been protected with a password, you must enter it to modify the box properties. Users 
with an administrator privilege can modify all user box properties and public box properties by using their 
password.

Modifying box properties

 If you want to modify the public box properties, you must first log in as the system administrator.
 You cannot modify the password of a box that any user is currently accessing.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box whose properties you want to display and 
edit.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [File] menu and select [Properties].

The Box Properties window appears. In the Box Properties window, you can see the box properties.

5 If you want to edit the box properties, click [Change Properties].

The Change Box Properties window is displayed.

If you do not need to change the box properties, press [OK] on the above screen to complete the 
operation.
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6 Specify the following items as required and press [Save].

Change Box Password — Select this check box to edit the box password. When you select this check 
box, enter the password in the [Old Password], [New Password], and [Confirm New Password] boxes.
 Old Password — Enter the current box password. This option is enabled only when you select the 

[Change Box Password] check box.
 New Password — Enter the new box password. This option is enabled only when you select the 

[Change Box Password] check box.
 Confirm New Password — Enter the new box password again. This option is enabled only when 

you select the [Change Box Password] check box.

If you forget the old password, you can enter the administrator password in the [Old Password] box 
instead of it.

Delete document automatically — Select this check box to automatically delete the documents in this 
box. When you select this check box, enter the number of days in the [Preservation Period for 
Documents] box.
 Preservation Period for Documents — Enter the number of days that the documents will be 

preserved. The documents will be deleted after the specified number of days have passed. If you set 
this period to 1 day, the document will be deleted automatically 24 hours later.

If a document is automatically deleted by the [Delete document automatically] function, the delete 
history is not stored in the log. 
For details of the logs, refer to the TopAccess Guide.

Send Email when an error occurs — Select this check box to send a notification message to the 
specified Email address when an error occurs. When you select this check box, enter the Email 
address in the [Email Address] box.
Send Email when job is completed — Select this check box to send a notification message to the 
specified Email address when a job is complete. When you select this check box, enter the Email 
address in the [Email Address] box.
Advance automatic delete notification — Select this check box to enable an Email notification 
message to be sent to the specified Email address 3 days before it automatically deletes the 
documents. When you select this check box, enter the Email address in the [Email Address] box.
 Email Address — Enter the Email address to which the notification will be sent.
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When the options “Send Email when an error occurs” and “Send Email when job is completed” are 
enabled, you are notified of whether or not the following e-Filing operations are successfully 
completed.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess [Administration] tab 
- Maintenance - Notification page. For more information, refer to the TopAccess Guide.

7 Click [OK] to close the Box Properties window.

Displaying folder properties
You can only view and confirm the folder properties. No operation to modify the folder properties is available.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folder whose properties you want 
to display.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

All folders and documents in the box are displayed in the Contents frame.

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the folder with the properties that you want to view and select 
[Properties] from the [File] menu.

The Folder Properties window appears. In the Folder Properties window, you can view the folder 
properties.

 Do not select several folders at the same time. You can only view the properties of one folder at 
a time.

 Users can also display the properties of a folder by selecting the folder in the Document frame, 
clicking on the [File] menu and selecting [Properties]. In that case, make sure that no document 
is selected in the Contents frame. If a document is selected, its properties are displayed instead 
of the selected folder.



4.HOW TO MANAGE USER BOXES/FOLDERS

Managing User Boxes and Folders    65

4 HOW TO MANAGE USER BOXES/FOLDERS

5 Click [OK] to close the Folder Properties window.

The following information is displayed in the Folder Properties window:
Location — Displays the directory where the folder is located.
Contains — Displays the number of files the folder contains.
Created — Displays the date and time the folder was created.
Modified — Displays the date and time the folder was last modified.
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How To Manage Documents

The e-Filing web utility allows you to manage the documents stored in the e-Filing system.
This section explains the following operations:
 P.68 “Displaying documents”
 P.69 “Renaming documents”
 P.71 “Deleting documents”
 P.72 “Printing documents”
 P.79 “Storing documents”
 P.82 “Archiving documents”
 P.88 “Sending Email”

Displaying documents
Two ways are available to view your document image files. The document view options are:
 Thumbnail view displays several files from a selected box, folder or several pages of the selected 

document. This is the default view. Use it to manage documents and files.
 P.68 “Using the thumbnail view”

 List view displays file names and properties in a tabular format. Use it to manage boxes and folders 
containing a large number of files.
 P.69 “Using the list view”

Using the thumbnail view
This is the default view, unless you choose a different one. It displays a small image of each file or folder (if 
you highlight a box or folder in the left frame) or each page (if you highlight a document in the left frame) with 
the file name or page number and a check box. Click the check boxes to select the files or pages that you 
want to move, copy, delete or print.
To return to the thumbnail view, go to the [View] menu and select [Thumbnail].
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Using the list view
This view displays boxes, folders, or file names with the properties and check boxes in a list format. You may 
find it more convenient than the thumbnail view for managing boxes and folders that contain a large number of 
files. Click the check boxes to select a single file or multiple files that you want to move, copy, delete or print.
To display your files by the list view, go to the [View] menu and select [List].

Renaming documents
This operation allows you to rename the documents.

Do not turn off the power of the equipment when changing the document name. The document will be lost 
if the power is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document you want to 
rename.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to rename and select [Rename] 
from the [File] menu.

The Rename Document window opens.

Users can also rename a document by selecting the document in the Document frame, clicking on 
the [File] menu and selecting [Rename]. In that case, even if you select the check boxes of pages in 
the Contents frame, e-Filing will only rename the selected document in the Document frame.

5 Enter the document name in the [Name] box and click [OK].

The confirmation dialog box appears.

Document names can consist of any ASCII characters except \ / < > " % & = ' ; : * ? | # [ ] { }. Do not 
use a space or period at the beginning or end of the name. The maximum size of a document name 
is 64 characters.
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6 Click [OK].

The document is renamed.

Deleting documents
This operation allows you to delete documents from the box or folder.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the documents you want to 
delete.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to delete and select [Delete] 
from the [Edit] menu.

The confirmation dialog box appears.

Users can also delete a document by selecting it in the Document frame, clicking on the [Edit] menu 
and selecting [Delete]. In that case, make sure that no pages are selected in the Contents frame. If 
any pages are selected, the alert message will be displayed because pages cannot be deleted in the 
View mode.

5 Click [OK].

The documents are deleted.

 Printing documents
You can print documents and images from boxes and folders in the e-Filing web utility. The following two ways 
are available to print them:
 P.72 “Printing an entire document”
 P.76 “Selecting test print”

 Printing an entire document
This operation allows you to print the entire document with various print options selected.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want 
to print.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to print and select [Print 
Document] from the [File] menu.

The Print window appears.

You can also print a document by selecting it in the Document frame and [Print Document] on the 
[File] menu. However, you cannot print individual pages even if you select the check boxes of the 
pages displayed in the Contents frame.
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5 Select the following print options as required and click [Print].

Duplex — Select whether you want the document printed on both sides of the paper. When you want to 
print the document on both sides, select the Book option to print vertically in the same direction to be 
bound along the vertical side of the paper so that the pages can be turned over right and left, or the 
Tablet option to print with a vertical reversal to be bound along the horizontal side of the paper so that 
the pages can be turned over up and down.
Number of Copies — Enter the number of copies to be printed.

The selectable range of the number of copies differs depending on the model.
- For the e-STUDIO6570C Series, e-STUDIO6550C, e-STUDIO856 and e-STUDIO857 Series

1 copy to 9,999 copies 
- Other models

1 copy to 999 copies 

Sort Copies — Select this option to output the document separately for each copy.
Group Copies — Select this option to output the document separately for each page.
Rotate Sort Copies — Select this option to output the document by changing the output orientation 
of each copy. This option is enabled only when you enter more than one copy in the [Number of 
Copies] box. When this option is selected, the Destination option is automatically set to the inner 
tray. To perform the Rotate Sort Copies, the portrait and landscape paper must be set in different 
drawers.

[Rotate Sort Copies] is not available for the e-STUDIO407CS Series and the e-STUDIO527S 
Series.

Paper Type — Select the type of paper desired.
Department Code — Enter the 1 to 63-digit department code, if required. You must enter the 
department code to print a document if the department code is enabled on the equipment.
Paper Source — Select the paper feed source. Select a paper source that correlates with the printing 
size.
Destination — Select the tray to which the document will be output.
Staple — Select whether the document is to be stapled or not. When you want to staple the document, 
select how it will be done.
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If you enable the Staple option after enabling the Interleave Pages option, the latter will be 
automatically disabled.

Binding — Select this option to output the document folded or stapled at the center. You can set how 
the document is output.
 Center Fold — The document is folded at the center.
 Saddle Stitch — The document is double-stapled and folded at the center.

 “Binding” is enabled only when the optional Saddle Stitch Finisher is installed.
 "Center Fold" can be selected only when e-STUDIO6570C Series, e-STUDIO6550C Series, 

e-STUDIO4540C Series, e-STUDIO507 Series or e-STUDIO456 Series is used.

Hole Punch — Select whether the document is to be hole-punched or not. When you want to hole-
punch the document, select how it will be done.

“Hole Punch" is enabled only when the optional Hole Punch Unite is installed.

Page Number - Position — Select whether the page numbers are to be printed on the pages. When 
you want to print the page numbers, select where it will be done.
Page Number - Initial Page — Enter the first number that applies to the first page of the document. 
When the Cover/Sheet Insertion - Use Front Cover option is enabled, the front cover is counted as the 
first page, and the first page of the document is counted at the second page.
Time Stamp - Position — Select whether the print time is printed on each page or not. When you want 
to print the time stamp, select where you want it to be done.
Image Shift - Position — Select whether the printed images are to be shifted or not. When you want to 
shift the printed images, select it to be done.
Shift Margin - Front — Select the width of the margin that is to be added to the side when the printed 
images are shifted.
Shift Margin - Back — Select the width of the margin that is to be added to the opposite side when the 
printed images are shifted.
Cover/Sheet Insertion - Use Front Cover — This option sets front cover printing which allows you to 
insert or print a cover on a sheet fed from a different tray than the Paper Source option. To enable front 
cover printing, select the check box and specify the location from where the cover sheet is to be fed and 
the print style to be used.
Cover/Sheet Insertion - Use Back Cover — This option sets back cover printing which allows you to 
insert or print a cover on a sheet fed from a different tray than the Paper Source option. To enable back 
cover printing, select the check box and specify the location from where the cover sheet is to be fed and 
the print style to be used.
Cover/Sheet Insertion - Insert Pages — This option sets sheet insertion printing which allows you to 
insert a sheet between pages, or print a specific page on a sheet fed from a tray other than the Paper 
Source option. This option is useful when you want to insert a blank sheet between chapters, or when 
you want to print chapter cover pages on different paper. To enable sheet insertion printing, select the 
check box and specify the location from where the inserted sheets are to be fed and the print style to be 
used. Then enter the page numbers you want to insert, separating them with commas if multiple pages 
are specified, in the [Pages] box.
Cover/Sheet Insertion - Interleave Pages — This option sets the interleaving page feature that is 
useful when you want to insert paper of a different type (or from another source) between every page of 
your print job. For example, you could use this option to insert blank, colored sheets between overhead 
transparencies. To enable interleaving pages, select the check box and specify the location from where 
sheets are to be fed. Also, select the [Duplicate] check box if you want to print the previous page 
images on the inserted sheet.

If you enable the Interleave Pages option after enabling the Staple option, the latter will be 
automatically disabled.
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Paper Type (Insert) — When you select the Bypass Feeder option for the paper source of either the 
Use Front Cover, User Back Cover, Insert Pages, or Interleave Pages option, select the paper type for 
the paper fed from the bypass tray.

When both the user management and department management settings are enabled, the quotas 
that are allowed for the department and user will be displayed in the upper right-hand area of the 
page.

Scheduled Print — Select this option to print a job at a future date and time. When this option is 
selected, set the date and time to print the job in the [Date & Time] box.

 Clicking [Print] prints the document, and the print result window is displayed.
 Clicking [Cancel] closes the Print window without printing.
 Clicking [Reset] restores the default print properties settings.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] 
tab > [Print], select the job and press [Delete].

 Selecting test print
This operation allows you to simply print a copy of a document by using the default print properties settings.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want 
to print.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to print and select [Test Print] from 
the [File] menu.

The Test Print window appears.

You can also perform test printing by selecting a document in the Document frame and then 
selecting [Test Print] on the [File] menu. However, you cannot print individual pages, even if you 
select the check boxes of the pages displayed in the Contents frame.
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5 Select whether to print all pages of the document or only specified pages and click 
[Print].

All Pages — Select this option to print all pages of the document.
[first page number] - [last page number] Pages — Select this option to specify the pages to be 
printed. When this option is selected, enter the numbers of first page and last page to be printed in each 
box.
Department Code — Enter a department code. This must be entered only when the department code 
is enabled on the equipment.

 When both the user management and department management settings are enabled, the quotas 
that are allowed for the department and user will be displayed in the upper right-hand area of the 
page.

 Clicking [Print] prints one copy of the document and the print result window is displayed.
 Clicking [Cancel] closes the Test Print window without printing.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] 
tab > [Print], select the job and press [Delete].
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 Storing documents
From an application that runs under the Windows operating system, you can send a document as a print job 
to e-Filing with the printer driver.
You can store your documents in the public box or in a user box.
 P.79 “Saving a print job in the public box”
 P.80 “Saving a print job in a user box”

When you store a document in e-Filing by using the printer driver, the printed image (not the original 
document in your computer) will be stored in e-Filing.

 For more information about the printer driver, refer to the Printing Guide / User’s Manual Basic 
Guide.

 For a detailed explanation of the public box and user box, see the following page:
 P.6 “e-Filing Features”

 You can also store a scanned document in e-Filing by using the control panel. For details, see the 
following page:
 P.18 “Storing Documents”

 Saving a print job in the public box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be 
different depending on the application that you are using. Refer to your application manual about 
displaying the [Printing Preferences] dialog box.

To use this function, the printing function is required.
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4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.
3) Click [OK].

5 Select [Public Box] to save the print job and click [OK].

 If you print a job as well as saving it in the public box, select the [Print] check box.
 If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.

To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

6 Click [OK] or [Print] to save the print job.
The print job is saved in the public box.

 Saving a print job in a user box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be 
different depending on the application that you are using. Refer to your application manual about 
displaying the [Printing Preferences] dialog box.



5.MANAGING DOCUMENTS

How To Manage Documents    81

5 MANAGING DOCUMENTS

4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.
3) Click [OK].

5 Select a user box to save the print job.
1) Select the desired user box number from the [Store to] box.
2) Enter the password for the user box in the [Password] box.
3) If you print a job as well as saving it in the user box, select the [Print] check box.
4) Click [OK].

If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

If the Enable SNMP Communication option is enabled on the [Configuration] tab, only the user 
boxes that have been set up will be displayed in the drop-down list box.

6 Click [OK] or [Print] to save the print job.
The print job is saved in the specified user box.
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Archiving documents
The e-Filing web utility allows you to archive the documents stored in e-Filing and download the archived files 
to your computer. These files can also be uploaded from your computer to e-Filing in the equipment, or other 
equipment of the same e-STUDIO series.
 P.82 “Downloading an archived document”
 P.85 “Uploading archived documents”

The archive files are compatible with the same series of the TOSHIBA MFP, not with another series. For 
example, archived files downloaded from the e-STUDIO4540C can be uploaded in a TOSHIBA MFP in the 
e-STUDIO4540C Series, not in the e-STUDIO6550C Series, e-STUDIO456 Series, e-STUDIO856 Series, 
e-STUDIO2550C Series, e-STUDIO5055C Series, e-STUDIO6570C Series, e-STUDIO507 Series, 
e-STUDIO857 Series, e-STUDIO407CS Series, e-STUDIO527S Series, e-STUDIO306LP and 
e-STUDIO307LP.

Downloading an archived document
You can archive the documents in the box and download it to your computer. Use this feature to create a 
back-up file of your documents in e-Filing.
The following procedure describes an example of how to download an archived document when using 
Microsoft Internet Explorer.

 The archived file contains all the documents you have specified to the archive, but you cannot open the 
documents on your computer.

 You can create an archived file that contains multiple documents in the same folder or the same box.
 You cannot create an archived file that contains more than 2 GB of data.
 Do not close the main window and child window by clicking [X]. If you do, downloading the archived 

documents becomes impossible. If you close the window by clicking [X] by mistake, turn the power to 
the equipment off and then on again.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want 
to archive.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to archive and select [Archive 
Document] from the [File] menu.

The confirmation dialog box appears.

Users can also archive a document by selecting the document in the Document frame, clicking on 
the [File] menu and selecting [Archive Document]. However, you cannot archive individual pages, 
even if you select the check boxes of the pages displayed in the Contents frame.

5 Click [OK] to start archiving the document.
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6 The Archive Document window appears. During archiving, you can quit the process by 
clicking [Cancel].

When archiving the document has been completed, “Your document has been archived successfully” is 
displayed.

Do not perform any operation while the e-Filing web utility is running busy.

7 Click the file name link to download the archived file.

The [File Download] dialog box appears.

8 Click [Save].

The [Save As] dialog box appears.
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9 Locate the folder where you want the archived file saved and click [Save].

This starts downloading the file.

10 Click [Close].

Uploading archived documents
If you have an archived file that has been downloaded from the equipment to your computer, you can upload 
it to e-Filing. When you upload the archived file, the file is automatically extracted and documents will be 
created in the box specified.

 If the same name document already exists in the box, the extracted document will be renamed by 
adding a 3-digit number to the original name.

 Do not close the main window and child window by clicking [X]. If you do, uploading the archived 
documents becomes impossible. If you close the window by clicking [X] by mistake, turn the power to 
the equipment off and then on again.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder where you want to upload the archived 
documents.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select [Upload Archived Document] from the [File] menu.

The Upload Archived Document window appears.

5 Click [Browse].

The [Choose File] dialog box appears.
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6 Select the archived file to be uploaded and click [Open].

This will return you to the Upload Archived Document window, and the folder path of the selected file 
will be displayed in the [Archived File] box.

7 Click [OK].

The confirmation dialog box appears.

8 Click [OK] to start uploading the archived file.

If you select an archived file unsupported in your model or a file other than an archived one, an error 
message appears. In that case, select the correct archived file and try again.

9 The Upload Archive Document window shows the process of uploading. During the 
uploading process, you can quit uploading by clicking [Cancel].

When uploading the archived file has been completed, “Your document has been uploaded 
successfully” is displayed.

Do not perform any operation while the e-Filing web utility is running busy.
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10 Click [Close].

The documents are added to the selected box.

 Sending Email
You can send the selected documents as Emails from the e-Filing web utility.
When you perform this function, the equipment creates an Email with the selected documents as an attached 
file and sends the Email directly from the equipment.

 To use the Send Email function, the Email configuration of the equipment needs to be set by the 
network administrator.

 When using a multifunctional digital color system (color MFP), you can send e-Filing documents as 
Emails only when they have been saved under the conditions noted below. Check the document 
properties before sending the documents.
- Documents which were saved with the copy function of the equipment in the black - TEXT/PHOTO 

or black - TEXT mode
- Documents which were saved with the scanning function of the equipment
- Documents which were saved with the received fax/Internet Fax transferred function

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want 
to send as an Email.

To use this function, the scanning function is required.
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3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to send as an Email and select 
[Send Email] from the [File] menu.

The Send Email page is displayed.

 Users can also send a document as an Email by selecting the document in the Document frame, 
clicking on the [File] menu and selecting [Send Email].

 Users can also send up to 100 individual pages or documents by selecting the check boxes 
displayed in the Contents frame.



5 MANAGING DOCUMENTS

90    How To Manage Documents

5 Specify the following items as required and click [Send].

[TO: Destination Setting] — Click this button to specify the destination. When you click this button, the 
Recipient List page appears. For instructions on how to specify the destination, see the following 
section:
 P.92 “Destination setting”
[CC: Destination Setting] — Click this button to specify the CC destination.
[BCC: Destination Setting] — Click this button to specify the BCC destination.
Subject — This option sets the subject of the Email documents. Select [Send data from (Device name) 
(Box Info.)] set by default, or enter the desired subject in the box. When you want to add the date and 
time to the subject, select the [Add the date and time to the subject] check box.
From Address — Enter the Email address of the sender. When the recipient replies, the message will 
be sent to this Email address.
From Name — Enter the sender’s name of the Email document.
Body — Enter the body message of the Email document. You can enter up to 1000 characters 
(including spaces).
File Format — Select the file format to which the received document will be converted.
 TIFF (Multi) — Select this option to save the scanned images as a multi-page TIFF file.
 TIFF (Single) — Select this option to save the scanned images separately as single-page TIFF files.
 PDF (Multi) — Select this option to save the scanned images as a multi-page PDF file.
 PDF (Single) — Select this option to save the scanned images separately as single-page PDF files.
 XPS (Multi) — Select this option to save the scanned images as a multi-page XPS file.
 XPS (Single) — Select this option to save the scanned images separately as single-page XPS files.
 JPEG — Select this option to save the scanned images as JPEG files. This option is selectable only 

when you have scanned the images with either [FULL COLOR] or [GRAY SCALE].
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 If the forced encryption setting is enabled, only [PDF (Multi)] and [PDF (Single)] are selectable for 
the file format. For the forced encryption function, refer to the MFP Management Guide / User’s 
Manual Advanced Guide.

 Files saved in the XPS format can be used in Windows Vista, Windows 7, and Windows Server 
2008, or Windows Server 2003 SP2 or later versions with Net Framework 3.0 installed.

Encryption — Set this option for encrypting PDF files if you have selected [PDF (Multi)] or [PDF 
(Single)] as the file format setting.
 Encryption — Select this check box if you want to encrypt PDF files.
 User Password — Enter a password for opening encrypted PDF files.
 Master Password — Enter a password for changing the encryption PDF setting.

 If the forced encryption setting is enabled, you cannot clear the [Encryption] check box. For the 
forced encryption function, refer to the MFP Management Guide / User’s Manual Advanced 
Guide.

 The user password and the master password are not set at the factory shipment. If the master 
password is to be set, ask your network administrator.

 A password must be entered in one-byte alphanumeric characters. The minimum and maximum 
numbers of characters allowed are 1 and 32.

 The user password must differ from the master password.

 These passwords can be re-entered only by an authorized user. Users cannot change the 
settings of the [Encryption Level] box and the [Authority] box noted below if they are not 
authorized to change the master password. Ask the administrator about resetting these 
passwords.

 For details of the encryption setting, refer to the MFP Management Guide / User’s Manual 
Advanced Guide. 

 Encryption Level — Select the desired encryption level.
- 40-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 3.0, 

PDF V1.1.
- 128-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 

5.0, PDF V1.4.
- 128-bit AES — Select this option to set an encryption level to the one compatible with Acrobat 

7.0, PDF V1.6.
 Authority — Select the check box of the desired type for the encrypt PDF authority.

- Printing
- Change of Documents
- Content Copying or Extraction
- Content Extraction for accessibility

File Name — Select how the attached file will be named. Select [DocYYMMDD] to name it as 
described, select [Original Document Name] to use the original document name, or you can enter the 
desired file name in the field.
Fragment Message Size — Select the size of the message fragmentation.
Department Code — Enter the department code if required.
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6 Click [Close].

Destination setting
On the Recipient List page, you can specify up to 400 destinations to send e-Filing documents as Email.
You can specify the recipients by entering the Email addresses manually, selecting the recipients from an 
address book, selecting the recipient groups from an address book, or searching the LDAP server for 
recipients.

If [LDAP Authentication] is selected in [Authentication Type], you can choose only destinations that are 
registered in the authenticated LDAP servers. For details of the LDAP Authentication option, refer to the 
TopAccess Guide.

 P.92 “Entering recipients manually”
 P.93 “Selecting recipients from an address book”
 P.94 “Selecting groups from an address book”
 P.95 “Searching the LDAP server for recipients”
 P.96 “Removing contacts from the recipient list”

Entering recipients manually

Follow the steps below to manually add a recipient to the Recipient List.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [New].

The Contact Property page is displayed.

3 Enter the Email address of the recipient in the [Destination] box and click [OK].

The entered recipient is added to the Recipient List page.

4 Repeat steps 2 and 3 to add all the recipients as required.

You can remove contacts once added to the recipient list before saving the destination settings.
 P.96 “Removing contacts from the recipient list”
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5 Click [Save].

The contacts are added as the destinations.

Selecting recipients from an address book

Follow the steps below to select recipients from an address book.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Address Book].

The Address Book page is displayed.

3 Select the Email check boxes of the users you want to add and click [Add].

The selected recipients are added to the Recipient List page.

 If you want to sort recipients into specific groups, select the desired group name in the [Group] 
box.

 You can remove contacts once added to the recipient list before saving the destination settings.
 P.96 “Removing contacts from the recipient list”

4 Click [Save].

The contacts are added as the destinations.
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Selecting groups from an address book

Follow the steps below to select groups from an address book.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Address Group].

The Address Group page is displayed.

3 Select the group check boxes containing the desired recipients and click [Add].

All recipients in the selected groups are added to the Recipient List page.

You can remove contacts once added to the recipient list before saving the destination settings.
 P.96 “Removing contacts from the recipient list”

4 Click [Save].

The contacts are added as the destinations.
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Searching the LDAP server for recipients

Follow the steps below to search the registered LDAP server for recipients.

To search the LDAP server for recipients, an administrator must set up the directory service by using 
TopAccess in the administrator mode. For details, refer to the TopAccess Guide.

1 Click [Destination Setting] to open the Recipient List page.

2 Click [Search].

The Search Contact page is displayed.

3 Specify the search condition.
1) Select the directory service name that you want to search in the [Directory Service Name] box.
2) Enter the search terms in the fields that you want to search.
3) Click [Search].

TopAccess will start searching the LDAP server for recipients, and the Search Address List page will 
display the results.

 If you select the model name of the equipment in the [Directory Service Name] box, you can 
search the address book of the equipment for recipients.

 TopAccess will search for the recipients that match the entries.
 Fill in at least one of the fields to perform a wild-card search.
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4 Select the Email check boxes of the users you want to add and click [Add].

The selected recipients are added to the Recipient List page.

You can remove contacts once added to the recipient list before saving the destination settings.
 P.96 “Removing contacts from the recipient list”

5 Click [Save].

The contacts are added as the destinations.

Removing contacts from the recipient list

1 Select the check boxes of the contacts that you want to remove from the recipient list, 
and click [Delete].

The selected contacts are removed from the recipient list.
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About the Document Control Buttons

The e-Filing web utility allows you to make changes to your stored documents before you print them.
Three document control buttons are provided in the e-Filing web utility: [Edit], [Save], and [Cancel].
These buttons are displayed at the top of the Contents frame when you select a document in the Document 
frame. The buttons displayed vary depending on the document status.
 [Edit] — Click this button to start editing the document. Only this button is displayed when you are in the 

View mode, where the document status indicates “View”. When you click [Edit], the document status will be 
changed to “Editing”, [Save] and [Cancel] appear instead of [Edit], and you can edit the document. If you 
click this button when the document status indicates “In Use”, you cannot enter the Edit mode and the 
message “The Document is being used. Please try again later” is displayed.

 [Save] — Click this button to save the document that you have edited. This button is displayed only when 
you are in the Edit mode, where the document status indicates “Editing”. When you click this button, the 
document is saved and returns to the View mode.

 [Cancel] — Click this button to return to the View mode without saving the document. This button is 
displayed only when you are in the Edit mode, where the document status indicates “Editing”.

The document status is displayed to the left of these buttons. The document status indicates the following 
situations:
 In Use — This indicates that another user is currently editing the document.
 View — This indicates that the document is currently in the View mode, and you can only view the pages 

within the document.
 Editing — This indicates that the document is currently in the Edit mode, and you can edit the document.

When you edit or delete a document that is shared by other users, make sure to refresh the display to see 
the latest status of the document. If the two or more users try to edit or delete the document or the page at 
the same time, the data may be damaged.
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Editing With Pages in Your Documents

The e-Filing web utility allows you to copy, move, delete and insert pages and change the order of pages in 
your document.
 P.99 “Displaying document and page properties”
 P.100 “Copying pages from one document to another”
 P.105 “Copying pages from a document to a box or folder”
 P.109 “Deleting pages from a document”
 P.112 “Inserting a blank page into a document”
 P.115 “Moving pages within a document”

Displaying document and page properties
You can display the Document Properties and Page Properties windows that contain details of the document 
or page. To display the Document Properties window, select the check box of the document and select 
[Properties] from the [File] menu. To display the Page Properties window, select the check box of the page 
and select [Page Properties] from the [File] menu.

The Document Properties window contains the following information:

 Location
Displays the directory where the document is located.

 Total Page(s)
Displays the number of pages the document contains.

 Size
Displays the data size of the document.

 Created
Displays the date and time the document was created.

 Modified
Displays the date and time the document was last modified.

 Last Accessed
Displays the date and time the document was last accessed by any user.

 [OK]
Click this button to close the window.

The Page Properties window contains the following information:

 Format
Displays how the page is stored.
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 Resolution
Displays the resolution of the page.

 Image Size
Displays the pixel size of the page.

 Paper Size
Displays the paper size of the page.

 Size
Displays the data size of the page.

 [OK]
Click this button to close the window.

Copying pages from one document to another
You can copy or cut pages from a document and insert them into another one.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages 
you want to copy or cut.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.

The pages of the document are displayed in the Contents frame.

If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] 
changes the document status from the View mode to the Edit mode so that you can cut pages from 
the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or 
[Cut] from the [Edit] menu.

 When you have cut pages from the document, proceed to the next step after the process is 
completed.

 When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is busy.
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6 Click [Save] to save the document.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the document 
name, the original document will be overwritten.
The Contents frame displays the pages in the View mode.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.

8 In the Document frame, select the box or folder containing the document into which 
you want to insert the copied pages.
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9 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

10 In the Document frame, select the document into which you want to insert the copied 
pages, and click [Edit].

The pages of the document are displayed in the Contents frame, and the document status is changed 
to the Edit mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

11 Click the space between the pages where you want to insert the copied pages.

The arrow indicators move to the space between the pages where you clicked.
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12 Click the [Edit] menu and select [Paste].

The copied pages are inserted between the specified pages.

13 Click [Save].

The Save Document window appears.

14 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.
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Copying pages from a document to a box or folder
You can copy or cut pages from a document and save them in a box or folder as a new document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages 
you want to copy or cut.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.

The pages of the document are displayed in the Contents frame.

If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] 
changes the document status from the View mode to the Edit mode so that you can cut pages from 
the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or 
[Cut] from the [Edit] menu.

 When you have cut pages from the document, proceed to the next step after the process is 
completed.

 When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is running busy.
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6 Click [Save] to save the document.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.

8 In the Document frame, select the box or folder where you want to store the copied 
pages.
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9 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].

10 Click the [Edit] menu and select [Paste].

The document containing the copied pages is created in the selected box or folder.
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Deleting pages from a document
You can delete pages from a document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages 
you want to delete.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to delete, and click 
[Edit].

The pages of the document are displayed in the Contents frame, and the document status is changed 
to the Edit mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

5 Select the check boxes of the pages that you want to delete and select [Delete] from the 
[Edit] menu.

The confirmation dialog box appears.

6 Click [OK].

The selected pages are deleted.
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7 Click [Save] to save the document.

The Save Document window appears.

8 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.
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 Inserting a blank page into a document
You can insert a blank page into a document. You can select a different size for the blank pages.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document into which 
you want to insert a blank page.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document into which you want to insert a blank 
page, and click [Edit].

The pages of the document are displayed in the Contents frame, and the document status is changed 
to the Edit mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

5 Click the space between the pages where you want to insert a blank page.

The arrow indicators move to the space between the pages where you have clicked.

6 Click the [Layout] menu and select [Insert Blank Page].

The Insert Blank Page window appears.
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7 Select the paper size and orientation of the inserted blank page, and click [OK].

A blank page is inserted between the specified pages.

Its available size differs depending on the model.

8 Click [Save].

The Save Document window appears.

9 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.
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Moving pages within a document
You can move pages within a document to rearrange the page order.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages 
you want to rearrange.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to rearrange, and 
click [Edit].

The pages of the document are displayed in the Contents frame, and the document status is changed 
to the Edit mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

5 Select the check boxes of the pages that you want to move between other pages and 
select [Cut] from the [Edit] menu.

The selected pages are copied to the clipboard and deleted from the document.

Do not perform any operation while the e-Filing web utility is running busy.

6 Click the space between the pages where you want to insert the copied pages.

The arrow indicators move to the space between the pages where you have clicked.
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7 Click the [Edit] menu and select [Paste].

The copied pages are inserted between the specified pages.

8 Continue the procedure from steps 5 to 7 to rearrange the pages.

9 After you have completed rearranging the pages, click [Save].

The Save Document window appears.

10 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X] by mistake, turn the power to the equipment off and 
then on again.
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Moving and Merging Documents

You can move documents between boxes or folders. You can also combine several documents into one 
document.
 P.118 “Moving documents”
 P.120 “Merging documents”

Moving documents
You can move a document from one box or folder to another, to help you manage the documents.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want 
to move.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to move and select [Cut] from 
the [Edit] menu.

The selected documents are copied on the clipboard and deleted from the current box or folder.

Do not perform any operation while the e-Filing web utility is running busy.

5 In the Document frame, select the box or folder where you want to paste the 
documents.

6 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].



6 EDITING DOCUMENTS

120    Moving and Merging Documents

7 Click the [Edit] menu and select [Paste].

The documents are created in the selected box or folder.

Merging documents
You can copy an entire document and insert its pages into another document.
The document that you want to insert is the source document, and the document that you want to merge it into 
is the destination document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the source documents.

3 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the source documents and select [Copy] from the [Edit] 
menu.

The selected documents are copied to the clipboard.

Do not perform any operation while the e-Filing web utility is busy.

5 In the Document frame, select the box or folder containing the destination document.

6 If you select a box that is protected with a password, the Password Authentication 
window appears. Enter the password in the [Box Password] box and click [OK].

 If you enter an invalid password several times to open the box, you may not log in for a certain 
period since it will be regarded as an unauthorized access. When "Box is locked." appears and 
logging in cannot be performed, ask your administrator.

 The password input is displayed in the blank symbols.

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 In the Document frame, select the destination document, and click [Edit].

The pages of the document are displayed in the Contents frame, and the document status is changed 
to the Edit mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is 
currently editing the document.

8 Click the space between the pages where you want to merge the documents.

The arrow indicators move to the space between the pages where you have clicked.

9 Click the [Edit] menu and select [Paste].

The copied documents are merged between the specified pages.

If multiple documents have been copied, the documents are merged in order from the oldest one.
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10 Click [Save].

The Save Document window appears.

11 Enter the document name in the [Document Name] box and click [Save].

 If you rename the document, it will be saved as a new one. If you do not change the name, the 
original document will be overwritten.

 The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work 
properly. If you close the window by clicking [X], turn the power to the equipment off and then on 
again.
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This section describes system administration of the e-Filing features.

Safeguarding Data................................................................................................................ 126
Erasing boxes.....................................................................................................................................................126
Unlocking user boxes .........................................................................................................................................127
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Safeguarding Data

An administrator should periodically monitor e-Filing to make sure it has enough hard disk space for everyday 
operations. This section describes the administrator’s function that allows you to delete boxes and the 
unlocking method of the user boxes which have been locked by incorrect password entries.
 P.126 “Erasing boxes”
 P.127 “Unlocking user boxes”

 Erasing boxes
You can manually erase boxes in e-Filing if the data has been corrupted, for example, by a hard disk failure 
and is therefore no longer usable.

1 Log on to the Administrator page.
 P.42 “Logging in as a system administrator”
The Box Management page is displayed.

 It is recommended to archive the documents in the boxes before deleting them. Once the boxes 
have been deleted, you cannot restore the documents in the boxes.
 P.82 “Archiving documents”

 The Backup/Restore utility included in the Client Utilities CD-ROM or Client Utilities/User 
Documentation DVD allows you to back up data in the boxes.

You can display the Box Properties window by clicking the box number or box name link.

2 Select the check boxes of the user boxes that you want to delete and click [Delete].

The confirmation dialog box appears.

For more information about the Box Management Subtab, see the following page:
 P.46 “[Box Management] subtab”

3 Click [OK].

The selected user boxes are deleted from e-Filing.
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Unlocking user boxes
When the Lockout Setting of e-Filing is set to “Enable” in the Password Policy, if an incorrect user box 
password is entered a specified number of times consecutively, the user box is locked so that it cannot be 
used for a certain time. The system administrator can unlock user boxes which have been so locked.

The Password Policy can be set in TopAccess. For details of the password policy, refer to the TopAccess 
Guide.

1 Log on to the Administrator page.
 P.42 “Logging in as a system administrator”
The Box Management page is displayed.

 For locked user boxes, “Locked” is displayed in the Status.
 You can display the Box Properties window by clicking the box number or box name link.

2 Select the check box of the user box that you want to unlock, and the click [Unlock].

The lock of the selected user box is released.

For more information about the Box Management Subtab, see the following page:
 P.46 “[Box Management] subtab”
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